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Introduction
Read this Instruction Manual thoroughly before using the product.
Thank you for purchasing the GCMS-QP series and GCMS-TQ series gas chromatograph mass spectrometer.
This manual is intended to explain basic operations to first-time users. Read this manual thoroughly before using the
product and operate the product in accordance with the instructions in this manual.
Also, keep this manual for future reference.
This manual assumes that the reader is knowledgeable of basic operations of Windows. For the operation of
Windows, refer to the instruction manual that comes with that product.

Important
• If the user or installation location changes, ensure that this Instruction Manual is transferred with the product.
• If this manual is lost or damaged, immediately contact your Shimadzu representative to request a replacement.
• To ensure safe operation, read all Safety Instructions before using the product.
• To ensure safe operation, contact your Shimadzu representative if product installation, adjustment, or reinstallation
(after the product is moved) is required.
© 2015-2016 Shimadzu Corporation. All rights reserved.
Original version is approved in English.
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Introduction
• All rights are reserved, including those to reproduce this manual or parts thereof in any form without written
permission from Shimadzu Corporation.
• Information in this manual is subject to change without notice and does not represent a commitment on the part of
the vendor.
• Any errors or omissions which may have occurred in this manual despite the utmost care taken in its production will
be corrected as soon as possible, although not necessarily immediately after detection.
• Shimadzu Corporation is not responsible for errors or injuries resulting from following the instructions in this
document.
• Shimadzu Corporation is not responsible for errors or injuries resulting from the use of equipment by the customer.
• The contents of PC hard drives may be lost due to unforeseen circumstances. In order to protect important data, be
sure to make backup copies on a regular basis.
• Microsoft, Windows and Excel are registered trademarks of Microsoft Corporation in the United States and/or other
countries.
Other company names and product names mentioned in this manual are trademarks or registered trademarks of
their respective companies.
The TM and R symbols are omitted in this manual.
• Replacement parts for this product will be available for a period of seven (7) years after the product is discontinued.
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Product Warranty
Shimadzu Corporation provides the following warranty for this product.
Details

1. Period:
2. Description:

Please contact your Shimadzu representative for information about the period of this
warranty.
If a product/part failure occurs for reasons attributable to Shimadzu during the warranty
period, Shimadzu will repair or replace the product/part free of charge. However, in the
case of products which are usually available on the market only for a short time, such as
personal computers and their peripherals/parts, Shimadzu may not be able to provide
identical replacement products.

3. Limitation of Liability

1) In no event will Shimadzu be liable for any lost revenue, profit or data, or for special,
indirect, consequential, incidental or punitive damages, however caused regardless of the
theory of liability, arising out of or related to the use of or inability to use the product, even if
Shimadzu has been advised of the possibility of such damage.
2) In no event will Shimadzu's liability to you, whether in contract, tort (including negligence),
or otherwise, exceed the amount you paid for the product.

4. Exceptions:

Failures caused by the following are excluded from the warranty, even if they occur during
the warranty period.
1) Improper product handling
2) Repairs or modifications performed by parties other than Shimadzu or Shimadzu
designated companies
3) Product use in combination with hardware or software other than that designated by
Shimadzu
4) Computer viruses leading to device failures and damage to data and software, including the
product’s basic software
5) Power failures, including power outages and sudden voltage drops, leading to device
failures and damage to data and software, including the product’s basic software
6) Turning OFF the product without following the proper shutdown procedure leading to device
failures and damage to data and software, including the product’s basic software
7) Reasons unrelated to the product itself
8) Product use in harsh environments, such as those subject to high temperature or humidity
levels, corrosive gasses, or strong vibrations
9) Fires, earthquakes or any other act of nature, contamination by radioactive or hazardous
substances, or any other force majeure event, including wars, riots, and crimes
10) Product movement or transportation after installation
11) Consumable items
Note:Recording media, such as floppy disks and CD-ROMs are considered consumable
items.

* If there is a document such as a warranty provided with the product, or there is a separate contact agreed upon that includes warranty
conditions, the provisions of those documents shall apply.
The warranty period for products with special specifications or for system products is specified separately.
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About This Operation Guide
Notation
This operation guide uses the notation described below.
Notation

! CAUTION

Meaning
Indicates a potentially hazardous situation which, if not avoided, may result in minor to moderate
injury or equipment damage.
Indicates additional information that is provided to ensure the proper use of this product.

^ Reference

Indicates the location of related information.
Indicates information provided to improve product performance.

[ ]

Indicates items displayed on the screen, such as buttons, menu selections, settings, windows, and
icons. Example: Click [OK].
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Safety Precautions
To ensure safe product operation, read these important safety instructions carefully before use and follow all
DANGER, WARNING and CAUTION instructions given in this section.

! WARNING
• For repairs, contact Shimadzu or your Shimadzu representative.
Not doing so could cause a fire, electrical shock, or injury.
• Do not modify or disassemble the instrument without the express approval of an authorized
Shimadzu representative.
Doing so could cause an accident from electric shock or a short circuit. It could also cause injury or
instrument failure.
• Read the instruction manual thoroughly before handling or operating the equipment, and be sure to
following the procedures described.
Not handling the equipment as described is potentially dangerous.

 Installation Site Precautions
! WARNING
• The solvents used with the gas chromatograph mass spectrometer may be flammable or toxic. Install
the product in a well-ventilated room.
Otherwise, solvent vapors may cause poisoning, or ignite and cause a fire.

• Do not install this instrument in a location with flammable or explosive gases or liquids.
Because this product is not designed to be explosion proof, doing so could cause a fire or explosion.

• Do not place flammable materials near the column oven exhaust at the back of the instrument, as
they could ignite and cause a fire.
• The lab table or other surface on which this instrument is installed should be level, stable, and
sufficiently strong to support the instrument's weight.
Otherwise, the unit could tip over or fall off the surface.

Do not install the instrument in a location with corrosive gases, gases containing organic solvents, halogen compounds,
or siloxanes, oil mist, or high levels of debris/dust. The instrument performance could be affected and its service life
hortened.
Do not operate the instrument in an environment where condensation may form. Doing so could cause it to malfunction.
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 High-Pressure Gas Precautions
! WARNING
• A high-pressure gas cylinder will be used to supply the carrier gas. When handling the gas cylinders,
observe the following suggestions.
• Keep gas cylinders in a well-ventilated area outside of the instrument installation site. Avoid exposure to
direct sunlight. Use lines to transport the gas from the cylinders to the instrument. For flammable gases, this
precaution is required by law.
• Do not place the high-pressure gas cylinder in a location where the temperature can exceed 40 °C.
• Choose an instrument installation site with sufficient ventilation, and include checking for gas leaks using an
electronic gas leak detector in your daily inspection procedure. Do not smoke or use open flames within 5 m
of the instrument when using highly combustible gases, such as acetylene and hydrogen, or potentially
combustible gases, such as oxygen and nitrous oxide. Install and maintain effective fire extinguishers.
• Secure the high-pressure gas cylinder with a cylinder stand or chain, etc., so that it does not fall over.
• Be sure to use a pressure release valve specified as "not to be used with oil." Also, do not use a pressure
release valve having piping, that is in contact with gas, whose inner surface is oily.
• When finished using the gas, immediately close the main cylinder valve.
• Verify that the pressure gauges are functional at least once every three months.
• Warning signs (adhesive aluminum plates) are available to indicate hydrogen gas use. Ask your Shimadzu
representative for more details. Signs are supplied free of charge to sites in which they are mandatory.

• Legal authorization is required to use cylinders with a capacity of 300 m3 or greater.

 Operation Precautions
! WARNING
• Always wear safety glasses or goggles when handling solvents. If solvent gets into the eyes,
blindness could result. Should solvent get into the eyes, immediately flush with large amounts of
water and seek medical attention.
• Do not place solvents near PCs, printers or other instruments, as fire or instrument damage could
result.
• Do not use flammable sprays (hair sprays, insecticide sprays, etc.) near this instrument, as they could
ignite and cause a fire.
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Handling Emergencies
The following measures should be taken in the event of an emergency such as a malfunction of the gas
chromatograph mass spectrometer.
Take adequate precautions and contact your Shimadzu representative as necessary before resuming use of the
instrument.

 Emergency Shutdown Procedure
1

Turn OFF the gas chromatograph mass spectrometer.

2

Turn OFF all accessories.

3

Close the valves for the pipes supplying carrier gas, CID gas, hydrogen, and air.

4

Disconnect the power supply.

 If the power cable is attached to a switchboard, turn OFF the switchboard.
 If the power cable is plugged into an outlet, unplug the cable.
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Overview

1

Two operation guides, Basic Operation Guide and Method Development Guide, are available for the
GCMS-QP series and TQ series models.
This document covers the basic operations related to the QP series and TQ series.
Name

Contents

Basic Operation
Guide

Covers the procedures to perform analysis using the existing method files for the GCMS-QP
series or TQ series models and to create new method files (for Scan mode or SIM mode).

Method Development Guide

Mainly covers the procedures to create method files (for SIM mode or MRM mode, etc.)
using the Smart database.

Icons and windows for functions that can only be used on the TQ series, QP2100 Ultra, QP2100 SE or
QP2020 will not be displayed on the software if the GCMS model used is QP2010, QP2010 Plus or
PARVUM2.

Indicates the procedure that can be used on the GCMS-TQ series models.
Indicates the procedure that can be used on the GCMS-QP2010 Ultra, GCMS-QP2010 SE
or GCMS-QP2020 models.

1.1 Programs

1
1
1
1
1
1
1
1

GCMSsolution is made up of the programs described below.
Select the program that is appropriate for the purpose (e.g., analysis or data processing).
Icon

Name
GCMS Real
Time Analysis

Description
Used to start up and shut down the instrument, make configuration
settings, and perform analysis.

1
1
1

GCMS Analysis
Editor

Used to create and edit method files and batch files during analysis.

GCMS Postrun
Analysis

Used to perform qualitative and quantitative processing, print reports, and
perform other tasks involving data processing.

1
1
1
1
1
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Icon

Name

Description

GCMS Browser

Used to perform qualitative and quantitative processing, print reports, and
perform other data processing tasks for multiple data files.

1.2 Routine Analysis Operation Flowchart
1 Prepare for analysis
•
•
•

^ P.18

Maintenance
Auto tuning
Create folder

2 Acquire data

^ P.19

3 Analyze data
•
•
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Qualitative analysis
Quantitative analysis

^ P.34
^ P.54

1.3 Flowchart of Qualitative and Quantitative Analyses

1.3 Flowchart of Qualitative and Quantitative Analyses
Start up GCMS system
•
•
•
•

^ P.4

Switch the power ON
Specify maintenance and configuration settings, etc.
Start up vacuum system
Check for vacuum leaks

^ P.12

Execute autotuning

Qualitative Analysis

1 Create method file
•
•

Quantitative Analysis
^ P.25

Specify instrument parameters
Specify (Q3) Scan mode
Specify similarity search
parameters

2 Acquire data

^ P.30

1 Perform qualitative analysis
(standard sample)

^ P.25

Use standard samples to confirm retention
times for target compounds

2 Create method file

^ P.44

<Quantitative analysis using (Q3) Scan mode>
• Create compound table

3 Analyze data
•
•
•

^ P.34

Display mass spectrum
Perform similarity search
Register displayed spectrum

4 Print report
•
•

<Quantitative analysis using (Q3) SIM mode>
• Create compound table
• Create SIM table

3 Acquire data

^ P.50

4 Analyze data

^ P.54

^ P.39

Edit report
Output report

•
•

Check and correct
calibration curve
Calculate quantitative
values for samples with
unknown concentrations

5 Print report
•
•

Shut down the instrument
•
•

^ P.65

Edit report
Output report

^ P.68

Shut down the vacuum system
Switch the power OFF
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2

Starting GCMS

2.1 Turning ON the Power
Switch ON any peripheral or accessory equipment connected to the system, before switching ON the
main GCMS system.
Switch ON any sample pretreatment unit connected to the system before switching ON the GCMS
system.
When using a TQ series model, open the CID gas (argon gas) supply valve and supply the CID gas
required for measurements in MRM mode.

1

Turn ON the power to the GC.

GC power switch
MS

2

Front Side

GC

Turn ON the power to the MS.

MS power switch

MS

GC
Back Side

3

Turn ON the power to the PC, printer, and display.

4

Double-click the

(GCMS Real Time Analysis) icon.

The [GCMS Real Time Analysis] program starts.
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2.2 Layout of Operating Areas

5

Click [OK].

2

2.2 Layout of Operating Areas
1 Title Bar

1 Title Bar
2 Menu Bar

6 Data Explorer
4 Assistant Bar

3 Toolbar

5 Instrument
Monitor

GCMS Real Time Analysis
No.

Name

GCMS Program

2 Menu Bar

3 Toolbar

6 Data Explorer
4 Assistant Bar

GCMS Postrun Analysis
Explanation

1 Title Bar

Real Time Analysis,
Analysis Editor, Postrun
Analysis, and Browser

Displays the name of the program, process, and file
currently running or being processed.

2 Menu Bar

Real Time Analysis,
Analysis Editor, Postrun
Analysis, and Browser

Displays command menus corresponding to the window
currently open.

3 Toolbar

Real Time Analysis,
Analysis Editor, Postrun
Analysis, and Browser

Displays command tool buttons corresponding to the
window currently open.

4 Assistant Bar

Real Time Analysis,
Analysis Editor, Postrun
Analysis, and Browser

Command icons are arranged in order of typical operation
sequence. The assistant bar is named according to the
window that is currently open. For example, when the
[Batch] window is open, the assistant bar is named the
[Batch] assistant bar.

5 Instrument Monitor

Real Time Analysis

Displays analytical instrument parameter values in real
time.
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No.

Name

6 Data Explorer

GCMS Program
Real Time Analysis,
Analysis Editor, Postrun
Analysis, and Browser

Explanation
Used to easily load analytical data or method files. It lists
files in the selected folder, according to file type.

The assistant bar, instrument monitor, and Data Explorer can be shown or hidden by selecting [Show/Hide]
on the [View] menu.

2.3 Inspecting Consumable Items and Maintenance
Parts

Check the state of the GCMS consumable items using the procedure described below.

1

Move the mouse pointer over the icon for a consumable item in the instrument monitor
to display the current state and the recommended replacement point for the
corresponding item.
When a consumable item approaches its recommended maximum usage frequency, the background of
the corresponding icon turns black to alert the user.

This note is shown when mouse pointer is moved over the septum icon. This means that the septum has
been used 13 times out of a maximum 100 times.

When replacing the analysis column, or when a consumable item has passed its recommended
replacement point, perform maintenance with reference to "Appendix K Maintenance" P.104.
Depending on the analysis content, the appropriate replacement frequency may be greater than the
recommended frequency.
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2.4 System Configuration

2.4 System Configuration
Check and set the modules used for analysis using the procedures described below. If the column
has been changed, enter the column information using the procedure in the [MS Navigator] window.

2.4.1 Setting the Modules Used for Analysis

1

Click the [System Configuration] icon on the [Real Time] assistant bar.

2

Check that the components shown in the [Modules Used for Analysis] area correspond
to the actual modules in the GC/MS system that are to be used for the analysis.

1

2

3
If the modules to be used for current analysis do not correspond to the modules shown in
this window, set as shown in the following example:

1

Select [AOC-20i+s] in the [Available Modules] area if for example, AOC-20i with AOC-20s are to be
used for analysis.

2

Click

3

Click [Set].

to register the module in [Modules Used for Analysis].
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Setting the CID Gas
For the GCMS-TQ series model, the default is set to use CID gas (argon gas).
Turn OFF the CID gas to perform analysis using only the Q3 Scan or Q3 SIM mode.

1
2

3
4

Double-click

(MS) icon under [Modules Used for Analysis].

Deselect the [Use CID Gas] checkbox.

Click [OK].
Returns to the [System Configuration] sub-window.
Click [Set].
The configuration has now been set to use no CID gas. From now on, parameters regarding CID gas
will not be displayed.
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2.5 Vacuum System Startup

2.5 Vacuum System Startup
Open the carrier gas cylinder valve to supply carrier gas.
If carrier gas is being controlled by accessory/peripheral equipment, use that equipment to supply carrier
gas before starting the vacuum system.

1

Click the [Vacuum Control] icon on the [Real Time] assistant bar.

2

Click [Auto Startup].

3

When [Completed] is displayed, click [Close].

The [Vacuum Control] window opens.

The vacuum system starts.
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2.6 Checking for Vacuum Leakage

1
2

3

Wait for 10 minutes after starting up the vacuum system.
Click the [Tuning] icon on the [Real Time] assistant bar.
The [Tuning] window opens.

Click the [Peak Monitor View] icon on the [Tuning] assistant bar.
The [Peak Monitor] window opens.
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2.6 Checking for Vacuum Leakage

4

Check for vacuum leaks.

2,5

1

2

3

4

1
2
3
4

Click the arrow button in [Monitor Group] setting, and select [Water, Air] from the list.
Click
windows.

(Filament ON/OFF) to turn ON the filament. Peaks will be displayed in the three

Change the detector voltage gradually by clicking the up or down arrow buttons so that the peak
height for m/z 18 (water) corresponds to half the height of the display window.
Compare the peak heights for m/z 18 (water) and m/z 28 (nitrogen).
Check that the peak height for m/z 28 (nitrogen) is not more than twice that for m/z 18 (water).

If the peak height for m/z 28 (nitrogen) is more than twice that for m/z 18 (water), it is possible that
there is an air leak. Search for the location of the leak. Refer to the System User's Guide for details
on how to check for vacuum leaks.

5

5

Click

Click

(Filament ON/OFF) to turn OFF the filament.

button in the top-right corner to close the [Tuning] window.

The message [Save current tuning file?] is displayed. Click [No].
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6

Click the [Top] icon on the assistant bar.

2.7 Autotuning
Wait for approximately 2 hours (before starting qualitative analysis) or 4 hours (before starting
quantitative analysis) after starting up the vacuum system and then perform autotuning using the
procedures described below.
Perform autotuning periodically, even with the vacuum system operating.

Create calibration curves again after performing autotuning.

2.7.1 Setting Analysis Conditions
If no analysis conditions have been created, start from "2.7.2 Executing Autotuning" P.13.
If a method file is already created, parameters can be specified in the instrument according to the following
procedure.

However, parameters for an accessory or peripheral equipment, except for AOC-20 auto-injector/autosampler, cannot be specified by using the following procedure. When using an accessory/peripheral
equipment, set the parameters on the equipment itself, or by using the software specific to that equipment/
device.

1

Click the [Data Acquisition] icon on the [Real Time] assistant bar.

2

Click

The [Acquisition] window opens.

(Open) on the toolbar.

The [Open Method File] sub-window opens.
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2.7 Autotuning

3

Select the method file to load, then click [Open].
The method file is loaded.

2

If the message "The hardware configuration for this method is different from the current instrument
configuration. The measurement condition in the method file is modified according to the current instrument
configuration." appears, click [OK] and click

4

(Save) on the toolbar.

Select [Download Initial Parameters] on the [Acquisition] menu.
The set parameters are transferred to the instrument. When the parameter values become equal to the
settings, [GC: Ready] and [MS: Ready] are displayed.

2.7.2 Executing Autotuning

1

Click the [Tuning] icon on the [Real Time] assistant bar.
The [Tuning] window opens.
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2

Click the [Peak Monitor View] icon on the [Tuning] assistant bar.

3

Select [New Tuning File] on the [File] menu.

The [Peak Monitor] window opens.

The [Select Tuning Mode] sub-window opens.

Select Tuning Mode appropriate for the application
When using a TQ series, QP2010 Ultra, QP2010 SE or QP2020 model and creating a new tuning file,
choose the tuning mode appropriate for the concentration level of target compounds being measured.
Since the tuning file is created with an emission current corresponding to the selected mode, it enables
measuring samples with an appropriate dynamic range.
• TQ series, QP2010 Ultra or QP2020: High concentration (20 µA), standard (60 µA, default), or high
sensitivity (150 µA)
• QP2010 SE:

High concentration (20 µA) or standard (60 µA, default)

Perform Autotuning Even with CID Gas OFF
When using a TQ series model, a tuning method can be chosen depending on the measurement mode.
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2.7 Autotuning

Table: Estimated Time Required for Autotuning
System
Configuratio
n

Tuning Condition

Perform Autotuning Even
Use CID Gas
with CID Gas OFF

Acquisition Mode
Time
Q3 Scan

Q3 SIM

MRM

Possible

Possible

Impossible

About 5 min

Possible *1

Possible *1

Possible

About 7 min

Possible

Possible

Possible

About 7 min
(Recommended time)

*1 : High sensitivity analysis
For GCMS-QP series models, autotuning takes about 3 minutes.

4

Select the filament to be used.

5

Click the [Start Auto Tuning] icon on the [Tuning] assistant bar.

6

Enter a file name and click [Save].
Autotuning starts.
When autotuning is completed, a report is printed.
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7

Click

(Save) on the toolbar.

If [Perform Autotuning Even with CID Gas OFF] is not selected, select [ON] in the [CID Gas] dropdown list to view the tuning resuts.
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2.7 Autotuning

2.7.3 Checking Autotuning Results

1

Check the results of autotuning.

2

2

1

4

1
2
3
4

3

Check that the FWHM (full width at half maximum) values are in the range 0.5 to 0.7.
Check that the detector voltage does not exceed 2 kV.
Check that the relative intensity ratio for m/z 502 is at least 2 % (for QP2010S and SE : 1 %).
Check that the peak intensity for m/z 69 is at least twice that for m/z 28.

If any irregularities are discovered above, possible causes could include a vacuum leak, poor
column connections, or contaminated ion source.
See "Appendix K Maintenance" P.104 to implement corrective measures.

Basic Operation Guide 17

3

3

Routine Analysis Flow

This chapter describes a series of routine analysis operations using the existing method files and batch
files.

3.1 Preparing for Analysis
When the ecology mode is set in the [GCMS Real Time Analysis] program, click [Cancel].

1

Inspect consumable items and maintenance parts.

2

Perform autotuning.

3

Create a new folder.

When a consumable item has passed its recommended replacement point, or when the column requires
maintenance, perform maintenance with reference to "Appendix K Maintenance" P.104.

Perform autotuning periodically (once every two weeks, for example) even with the vacuum system
operating, referring to "2.7.2 Executing Autotuning" P.13. When quantitative analysis is to be performed,
create calibration curves again after autotuning.

[Create New Project (Folder)] can be used to create a new folder at the same directory level as currently
open in Data Explorer and to copy the target files.
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3.2 Editing a Batch File

3.2 Editing a Batch File
For routine analyses, it may be more convenient to load an exiting batch file and partially edit it.
The following procedure describes how to edit information in specified rows(s) collectively.

1

Click the [Batch Processing] icon on the [Real Time] assistant bar.

2

Click the [Batch Processing] icon on the [Real Time] assistant bar.

The [Batch Table] window opens.

The [Batch Table] window opens.

(Example of a batch table for qualitative analysis)

(Example of a batch table for quantitative analysis)
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3

3 Routine Analysis Flow

3

Add or delete rows depending on the number of samples being analyzed.

1

2

Click on the row number to be edited to highlight the whole row.

Right-click on the selected row, and select the appropriate editing command from the menu that is
displayed.

Menus

Explanation

Copy Row

Copies the selected row.

Add Row

Adds a row to the end.

Insert Row

Inserts a new row above the selected row.

Paste Row

Pastes the copied row.

Delete Row

Deletes the selected row.

4

Drag the mouse from the row of the unknown sample to the row specified with serial

5

Select [Fill Down] on the [Edit] menu.

numbers.

The entire content of the first row is copied.
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3.2 Editing a Batch File

6

Select [Fill Series] on the [Edit] menu.
Edited parameters will be appended with serial numbers. Modify the sample name, etc. if necessary.

3
To collectively edit specified rows without changing other rows, right-click the cell in the first row and
click [Fill Down] or [Fill Series].

7
8

9

Select [Save Batch File As] on the [File] menu.
Open the folder where the method file is saved, enter a name, and save the file.

Set the syringe rinse solvent and samples in the autosampler.
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3 Routine Analysis Flow

10

Click the [Start] icon on the [Batch] assistant bar.
Analysis starts. When the "Do you want to go into the ecology mode after batch processing ends?"
message appears, click [Yes].

• To abort batch processing, click the

(Stop) icon on the [Batch] assistant bar.

• To execute only specified rows, select the rows by clicking or dragging the mouse, then start the
analysis.

• For details on how to create data file names automatically or how to change settings for
continuous data acquisition during the measurement, refer to "Appendix D Batch File" P.74.

3.3 Dana Analysis
^ Reference
Refer to "4.5 Analyzing Data" P.34 when performing qualitative analysis.
Refer to "5.3 Analyzing Data" P.54 when performing quantitative analysis.
Refer to "Appendix L Quantitative Browser" P.110 when quantitating multiple samples.
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4

4

Qualitative Analysis

4.1 Selecting a Folder

1
2

4
4

Start up the [GCMS Real Time Analysis] program.
Click the

(Data Explorer) icon on the toolbar to display Data Explorer.

4
4

3

4
Click

(Project (Folder) Selection).

4

The [Project (Folder) Selection] window opens.

4
4

4

4

Click the folder to be used.

4
4
4

5

4

Click [Close].

4
4
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4 Qualitative Analysis

Creating a Folder

1

Click the desired hard drive or folder and then click [New Folder].
The [Create New Folder] window opens.

2

Type a folder name and click [OK].
A folder is created in the drive or folder selected in step 1, and the [Project (Folder Selection)]
window returns.

24 Basic Operation Guide

4.2 Creating a Method File

4.2 Creating a Method File
Set the instrument (i.e., autosampler, GC, MS) parameters and similarity search parameters using the
procedure described below.

1

Click the [Data Acquisition] icon on the [Real Time] assistant bar.
The [Acquisition] window opens.

4

2

Select [New Method File] on the [File] menu.

4.2.1 Setting Autosampler Parameters

1

Click the [Sampler] tab and specify the number of rinses appropriate for the sample.
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4 Qualitative Analysis

4.2.2 Setting GC Parameters

1

Click the [GC] tab and set the analysis conditions.

1

23

4
7

6

1
2
3

5

Input an initial temperature for the column oven (40 to 100 °C).
Input an injection temperature based on consideration of the boiling point of the target compound
(200 to 300 °C).
Select [Split] or [Splitless].

Selecting Injection Mode
• Split: Select this mode if the concentration of the target compound is high. As a rough
guideline, select this mode when the target compound concentration is greater than
10 ng/uL.
• Splitless: Select this mode if the concentration of the target compound is low. As a rough
guideline, select this mode when the target compound concentration is less than
10 ng/uL.

4
5

Select [Pressure] when the method calls for a constant pressure mode, and select [Linear Velocity]
when the method calls for a constant linear velocity mode for the carrier gas. When no reference
method is available, select [Linear Velocity].
When no reference method is available, refer to the table "Typical Pressure Settings for Carrier Gas"
to set an initial value for the pressure. The linear velocity will be set automatically.
Typical Pressure Settings for Carrier Gas
Middle bore capillary column
(I.D. 0.25 mm)

6
7

Semi-wide bore capillary column
(I.D. 0.32 mm)

30 m

60 m

30 m

60 m

75 to 150 kPa

100 to 250 kPa

30 to 50 kPa

50 to 100 kPa

If "Split" is selected as the injection mode, enter a split ratio. If "Splitless" is selected, enter "-1.0".
Set appropriate conditions for separating the target compound from other peaks.
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4.2 Creating a Method File

4.2.3 Setting MS Parameters

1

Click the [MS] tab and set the analysis conditions.

3

1

4

4

1
2

2

5

6

Input [Interface Temp.] (200 to 300 °C).
Input [Start Time] and [End Time] according to the note below.

In the absence of information about the elution time of the solvent peak, set [Start Time] to zero
minutes, and set [End Time] to the [GC Program Time] value. After one analysis of a standard
sample or the solvent, and obtaining the solvent peak profile, change the [Start Time] to a time
after the end of the solvent peak (see the figure shown on page 24).

3
4

Click [Relative to the Tuning Result].
If peak intensity is too low, change the value within the range +0.1 to +0.3., as necessary.
Increasing the detector voltage by 0.1 kV increases the peak intensity by 2 to 4 times.
Input a value that is 0.5 minutes less than the [Start Time] setting. (If the resulting value is less than
zero, enter "0".)
Relationship between Start Time and Solvent Elution Time
Solvent peak

Peak of target compound

TIC
GC START

0.5 min
Start time (Detector ON)

Solvent elution time (Filament ON)

5
6

Select [Scan]. (For TQ series models, select Q3 scan.)
Enter the mass range to be measured, where [Start m/z] is the lower mass limit, and [End m/z] is the
upper mass limit. The typical value for [Start m/z] is 35, and the typical value of [End m/z] is the
highest molecular weight of the target compounds in the sample plus some margin of error (+15).
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4 Qualitative Analysis

4.2.4 Setting Similarity Search Parameters

1

Select [Qualitative Parameters] on the [Method] menu.

2

Click the [Similarity Search] tab and set the search conditions.

The [Qualitative Parameters] window opens.

1
3

2

1

Click

.

The [Open File] window opens.

Open the library to be used.
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4

4.3 Repeating Autotuning

2
3
4

To remove a library from the selection, highlight the library file name by dragging the mouse over it,
then press the [Delete] key.
Select [Do not include duplicate hits].
After completing the settings, click [OK] to return to the original window.

4.2.5 Saving the Method File

1

Select [Save Method File As] on the [File] menu.

2

Enter a file name and click [Save].

4

4.3 Repeating Autotuning
If autotuning has not been performed under the analysis conditions, perform the procedures described
under "2.7 Autotuning" P.12.
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4 Qualitative Analysis

4.4 Sequential Analysis
Create a batch file necessary for qualitative analysis and perform sequential analysis using the
procedures described below.

4.4.1 Creating a Batch File

1

Click the [Batch Processing] icon on the [Real Time] assistant bar.

2

Select [New Batch File] on the [File] menu.

3

Click the [Wizard] icon on the [Batch] assistant bar.

The [Batch Table] window opens.

The [Batch Table Wizard] window opens.
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4.4 Sequential Analysis

4

With the Batch Table Wizard, make the appropriate settings and create a batch table.

4

1
2
3
4

1
2
3
4

Click [Unknown Only].
Click

and specify the method file to be used.

Deselect both [Data Processing] items.
Click [Next].

5
6

7

5
6
7

Input [Vial #] and [Sample Count].
Input [Injection Volume].
Click [Next].
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4 Qualitative Analysis

8

9

8
9

Enter [Data File Name].
If the file name ends with a number, the files are named sequentially.
Click [Finish]. The batch table is displayed. Edit the batch table as required.

It is recommended to measure the blank (solvent, etc.) before starting analysis.
1. Insert a row above the first row.
2. Copy a row for the unknown sample and paste it on the first row.
3. Edit the vial #, sample name and data filename.
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4.4 Sequential Analysis

4.4.2 Saving Batch Files

1

Select [Save Batch File As] on the [File] menu.

4

2

Open the folder where the method file is saved, enter a name, and save the file.

4.4.3 Executing Sequential Analysis

1
2

Set the syringe rinse solvent and samples in the autosampler.
Click the [Start] icon on the [Batch] assistant bar.
Analysis starts.
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4 Qualitative Analysis

4.5 Analyzing Data
Use the procedure described below to perform basic qualitative data processing for data measured in
Scan mode, for examples, to display mass spectra, perform background subtraction, and perform
similarity search.

1

Double-click the

2

Click the [Qualitative] icon on the [Postrun] assistant bar.

(GCMS Postrun Analysis) icon.

The [GCMS Postrun Analysis] program starts.

4.5.1 Loading Data Files

1

Double-click the data file to analyze.
The data file opens. If the required folder is not found, refer to "4.1 Selecting a Folder" P.23.
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4.5 Analyzing Data

4.5.2 Displaying Mass Spectra
1

2 3

4
4

1

Specify a range in the TIC window by dragging the mouse so that both the peak top and baseline are
highlighted.
Drag the mouse so that both the peak top and baseline are displayed.To undo the zoom, right-click
in the MC window and select [Undo Zoom] on the pop-up menu.

2
3
4

Move the mouse pointer to the peak top and double-click.
Click

(Spectrum Subtraction) on the toolbar.

Double-click at the background processing position.

With the following types of peaks, process the parts indicated by arrows as background.
Example 1)

Example 2)

Example 3)

Background spectrum can
be subtracted from one of
positions.

If a red peak appears on a mass spectrum, it indicates that the peak is saturated. This spectrum has
a different pattern (intensity ratio) from the mass spectrum for the target compounds. In such a case,
click the left and right arrow buttons

to select a mass spectrum that shows no red

peaks.
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4 Qualitative Analysis

4.5.3 Searching for Similarity

1

Click the [Similarity Search] icon on the [Qualitative] assistant bar.

2

Check the similarity search results.

The [Similarity Search Results] window opens.

1

2
4

3
Spectrum
Display

Mass Spectra of
Searched Compounds

1
2
3

Use to switch between the mass spectra for the compounds found.
Select the checkbox for the applicable compound to enter a compound name in the spectrum table.
After checking the mass spectra, click

(Register Target Spectrum to Spectrum Process Table).

The mass spectrum is registered.

By registering the target mass spectrum in the spectrum process table, you can re-check the
similarity search results or output them in reports.

4

Close the [Similarity Search Results] window.
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4.5 Analyzing Data

4.5.4 Editing the Spectrum Process Table

1

Click the [Qualitative Table] icon on the [Qualitative] assistant bar.
The [Qualitative Table] window opens.

4

2
3

Click

(Maximize).

Double-click [Done] in the first row of the spectrum process table.

The [Similarity Search Results] window opens.
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4 Qualitative Analysis

To sort the spectrum process table in chronological order, click [Sort Table] on the [Edit] menu.

4

After check is complete, close the [Similarity Search Results] window.

• To edit a compound name, select the desired row and click [Edit Compound Name] on the [Edit]
menu. Enter the compound name in the [Edit Compound Name] window displayed and click [OK].

• To delete a row in the spectrum processing table, select the desired row and click [Delete Rows]
on the [Edit] menu.

5

Close the [Qualitative Table] window.

4.5.5 Saving Data Files

1

Click

(Save) on the toolbar.

The qualitative table is saved in the data file.
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4.6 Printing Qualitative Analysis Reports

4.6 Printing Qualitative Analysis Reports
It is convenient to use a template to create a report of analyzed data. Depending on the data, edit the
area of the chromatogram to display in the report, or edit the number of compounds to be displayed in
the report of similarity search results.

4.6.1 Loading Report Formats

4

1

Click the [Report] icon on the [Qualitative] assistant bar.

2

Click [New Format File] on the [File] menu.

3

Select [Use Template] and select the format [Qualitative Analysis Report].

4

Click [OK].

The [Data Report] window opens.

The [File New] window opens.

The [Qualitative Analysis Report] format opens.
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4 Qualitative Analysis

4.6.2 Editing Report Formats

1

Double-click on the chromatogram.

2

Click the [Chromato] tab.

3

In the [Area] area, deselect [Auto] for the X-axis and enter the time range.

The [GCMS Chromatogram Properties] window opens.
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4.6 Printing Qualitative Analysis Reports

4
5

Click [OK].
Click the next page icon on the toolbar to display the second page.

6

Double-click on the [Library] display item.

7

Click the [Result] tab.

4

The [GCMS Library Properties] window opens.
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4 Qualitative Analysis

8

Enter the [Maximum Compound Number] (maximum number of search results to
display).

• Selecting [Print the Hit Compounds] prints the report for the maximum number of search results to
display in order starting with the highest similarity.
• Selecting [Print Only Specified Compound] prints the report for the compounds selected for
registration in the similarity search.

9

Click [OK].
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4.6 Printing Qualitative Analysis Reports

4.6.3 Outputting Reports

1

Click the [Preview] icon on the [Data Report] assistant bar.
The print preview window opens.

4

2

After checking the report content, click [Print] to print the report.

3

Click

(Save) on the toolbar.

The report is saved as part of the data file.
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5

5

Quantitative Analysis

5.1 Creating a Method File
With reference to "4 Qualitative Analysis" P.23 analyze standard samples (including internal standard
substances when using the internal standard method for analysis) and register the retention times and
mass spectra of the target compounds in the spectrum process table.

5.1.1 Creating a Compound Table

1

Start the [GCMS Postrun Analysis] program and click the [Compound Table] icon on the

2

From Data Explorer, double-click the data file in which the spectrum process table for

3

Click the [Wizard (New)] icon on the [Compound Table] assistant bar.

[Postrun] assistant bar.
The [Create Compound Table] window opens.

the target compounds was saved.

The [Compound Table Wizard] window opens.
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5.1 Creating a Method File

4
5
6
7

Select [Use current Spectrum Process Table] and then click [Next] in the [Compound
Table Wizard 1/7] window.
Click [Next] in the [Compound Table Wizard 2/7] window.
Select a row in the table, check the mass spectrum for each compound, and click [Next]
in the [Compound Table Wizard 3/7] window.
Specify the calibration curve type, the quantitative method, and other parameters as
required, and click [Next].
1

5
4
5

3
No.

Item

2
Explanation

1

Quantitative
Method

• External Standard:Quantitation is performed using a calibration curve
obtained from the absolute quantity (concentration) and the area or height
value of the target compound in a standard sample.
• Internal Standard:An internal standard is added to the sample, the sample is
analyzed, and quantitation is performed using the relationship between the
relative sensitivity and the quantitative ratio with respect to the internal
standard compound.

2

Calculated by

Select [Area] or [Height]. Normally, select [Area].

3

# of Calib. Levels

Input the number of concentration levels of the calibration curve.

4

Unit

Set the concentration unit used for reports.

5

Format of
Concentration

Set the number of digits used to indicate concentrations.
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5 Quantitative Analysis

8

Make the appropriate settings for concentrations and measurement ions, and click [Next].

1
3
4
2

No.

9

Item

Explanation

1

Standard

Set the concentrations of the standard samples. If the concentration varies with the
compound, make the necessary corrections after completing the wizard procedure.

2

Internal Standard

Set the concentration of the internal standard.

3

# of Reference
Ions

Input the number of reference ions used to perform peak identification.

4

Decimal for mass Determine the number of decimal places for target ion and reference ion m/z values.
Selecting [1 Decimal] increases the sensitivity level.

Set the type, compound name, target ion, and reference ion for each substance. After
entering the required information for all the compounds, click [Next].

1
2

3

1
2

Change the compound displayed by changing the ID number.
Select [Target] in the [Type] list. Select [I.S.] when setting for an internal standard.
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5.1 Creating a Method File

3

Change the type and m/z value.
• To change the type, click cell for the type to be changed and select "Target Ion", "Ref. Ion", or "Not
used".
• To change the mass value, click in the cell containing that value, click the resulting arrow button,
point your cursor at the desired peak on the mass spectrum, and then double-click it.

5

10

Click [Finish].

11

Click

A compound table is created. Correct the contents of the compound table as required.

to set the compound table to the display mode.

To correct the compound table again, enter edit mode by clicking

at the top-right corner

of the table.

12

Click the [Save Compound Table] icon on the [Compound Table] assistant bar.
The method file that was used to acquire the data will be selected automatically.
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5 Quantitative Analysis

13

Click [Save].
This completes the procedure for creating a quantitative method for Scan mode.

If greater sensitivity is required, use the following procedure to create a quantitative analysis method
for the SIM mode.

5.1.2 Creating a SIM Table

1

Click the [Create MS Table [COAST]] icon on the [Compound Table] assistant bar.

2

Enter a file name and click [Save].

The [Select Method File] window opens.

The [Creation of Automatic MS Table [COAST]] window opens.
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5.1 Creating a Method File

3
4

Click

(Maximize) in the [Creation of Automatic MS Table [COAST]] window.

A SIM table is created automatically. Check the chromatogram and SIM table and, if
necessary, modify the table with reference to the following procedure.

5

• To ensure sufficient sensitivity:
To ensure sufficient sensitivity, it is best to specify no more than 20 m/z values per row (i.e. per
group).
If necessary, modify the SIM table.
• To edit table rows (i.e. groups):
To edit table rows (i.e. groups), right-click on the desired row and select the following on the menu
that appears.

• Add Row : Adds a row to the bottom of the table.
• Insert Row : Inserts a new row above the selected row.
• Delete Row : Deletes the selected row.
• To split groups:
To split groups, use the following procedure. (Example: Splitting Group 3 into two groups)
1. Click the third row of the SIM table.
2. Right-click on the table and select [Insert Row].
3. Click the inserted row and drag the mouse on the chromatogram to specify and enlarge the
desired area.
4. Click near the center of peaks labeled with compound names.
Group 3 is divided into two groups.

5

When finished, click [OK].
A method is created for SIM mode quantitative analysis.
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5 Quantitative Analysis

5.2 Sequential Analysis
Create a batch file necessary for quantitative analysis and perform sequential analysis using the
procedure described below.

5.2.1 Creating a Batch File

1

Start the [GCMS Real Time Analysis] program and click the [Batch Processing] icon on

2

Select [New Batch File] on the [File] menu.

3

Click the [Wizard] icon on the [Batch] assistant bar.

the [Real Time] assistant bar.
The [Batch Table] window opens.

The [Batch Table Wizard] window opens.
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5.2 Sequential Analysis

4

Make the appropriate settings with the Batch Table Wizard and thereby create a batch
table.

1

2

5

3
4

1
2
3
4

Select [Standard & Unknown].
Click

and specify the method file to be used.

Select [Quantitative].
Click [Next].

5
7
6

8

5
6
7
8

Input [Vial #].
The number of calibration points is loaded automatically from the method.
Input [Injection Volume].
Input [Average Count] (i.e., the number of repetitions).
Click [Next].
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5 Quantitative Analysis

9

10

9
10

Enter [Data File Name].
If the file name ends with a number, the files are named sequentially.
Click [Next].

11
12
13

14

11
12
13
14

Input [Vial #].
Input [Sample Count].
Input [Injection Volume].
Click [Next].
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5.2 Sequential Analysis

15

5

16

15
16

Enter [Data File Name].
If the file name ends with a number, the files are named sequentially.
Click [Finish].
The batch table is displayed.

It is recommended to measure the blank (solvent, etc.) before starting analysis.
1. Insert a row above the first row.
2. Copy a row for the unknown sample and paste it on the first row.
3. Edit the vial #, sample name and data filename.

5.2.2 Saving Batch Files

1

Select [Save Batch File As] on the [File] menu.
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5 Quantitative Analysis

2

Open the folder where the method file is saved, enter a name, and save the file.

5.2.3 Executing Sequential Analysis

1
2

Set the syringe rinse solvent and samples in the autosampler.
Click the [Start] icon on the [Batch] assistant bar.
Analysis starts.

5.3 Analyzing Data
5.3.1 Checking and Correcting Calibration Curves

1

Start the [GCMS Postrun Analysis] program and click the [Calibration Curve] icon on the
[Postrun] assistant bar.
The [Calibration Curve] window opens.
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5.3 Analyzing Data

2

Double-click the method file used in analysis from Data Explorer.

3

Select a compound in the compound table and click the calibration curve level.
Check the calibration curve created and the chromatogram.

^ Reference
If no peaks are identified or detected, perform identification or peak integration with reference to
"Manual Identification and Manual Peak Integration" P.57.
To change the method used to plot calibration curves, see "Appendix I Editing Parameters for
Quantitative Analysis" P.96.
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5

5 Quantitative Analysis

4

Only after correcting the calibration curves, click

(Save) on the toolbar to save the

method file.

Peaks that are detected in the chromatograms after automatic peak integration, will have peak
detection marks (

).

The detected peaks are subjected to identification based on the retention times and ion ratios
(

peak identification mark).
Peak identification mark

Peak detection marks

Chromatogram
No peaks are detected.
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Countermeasure
Perform manual peak integration.
(P.58)

5.3 Analyzing Data

Chromatogram

Countermeasure

Peaks are detected but different peaks are identified.

Perform manual identification.
(P.57)

Peaks are detected and identified but peak integration is not performed
properly.

Perform manual peak integration.
(P.58)

Manual Identification and Manual Peak Integration
If no peaks are identified or detected, perform identification or peak integration using the procedure
described below.
Manual Identification

1

Right-click in a chromatogram and select [Manual Identification] from the displayed
menu.
A bar is displayed.
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5

5 Quantitative Analysis

2

Click the peak to be identified.
The peak is identified.

Manual Peak Integration

1

Right-click in a chromatogram and select [Manual Peak Integrate«] from the displayed

2

Drag the mouse from the start point to the end point of the peak.

menu.
A bar is displayed.

The [Select Base Line] window opens.
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5.3 Analyzing Data

3

Select the baseline and click [OK].
The peak is integrated and identified.

5
The same process can be accomplished by performing the following operations on the
chromatogram.
Process
Manual Identification

Operation
[Shift] + [Ctrl] + right-click

Explanation
Identifies integrated peaks.

Manual Peak Integration [Shift] + right-click-drag

Connects start point and end point as
baseline.

Manual Peak Integration [Ctrl] + right-click-drag

Connects points with horizontal baseline.

5.3.2 Re-quantifying after Correcting a Calibration Curve
After correcting a calibration curve, re-quantify the data for samples with unknown concentrations.

1

Click the [Batch Processing] icon on the [Postrun] assistant bar.

2

Select [New Batch File] on the [File] menu.

The [Batch Table] window opens.
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5 Quantitative Analysis

3

Click the [Select Data File] icon on the [Batch] assistant bar.

4

Click the data file for sample with unknown concentrations, for which re-quantification

The [Select Data File] window opens.

is to be performed and click

(Add).

The data file is selected.

5
6

Click [OK].
A batch table is displayed. Assign a name to the batch file and save it.
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5.3 Analyzing Data

7

Click the [Start] icon on the [Batch] assistant bar.
The data is re-quantified using the corrected calibration curve.

5

5.3.3 Checking and Correcting Quantitation Results
Check the quantitation results for the samples with unknown concentrations.

1

Click the [Quantitative] icon on the [Postrun] assistant bar.

2

Double-click the data file to be checked from Data Explorer.

3

Click the [Results] tab in the [Compound Table View].

The data file being checked opens.

The quantitation results are displayed.
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5 Quantitative Analysis

4

Display the standard spectra sub-window and reference data sub-window in the
[Quantitative View] area.
If necessary, see "Displaying Standard Spectra" P.63 ,"Displaying Reference Data" P.64 to display
information about identified compounds.

Standard Spectrum

Reference Data

5

Click on a compound name in the compound table and check the chromatogram in the
[Quantitative View].
Check the results while viewing the peak identification/detection marks and baseline in the
chromatogram.

Qantitative View

^ Reference
If necessary, perform identification or peak integration with reference to "Manual Identification and
Manual Peak Integration" P.57.

The same process can be accomplished more easily by performing the following operations on the
chromatogram.
Process
Manual Identification

Operation
[Shift] + [Ctrl] + right-click

Manual Peak Integration [Shift] + right-click-drag
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Explanation
Identifies integrated peaks.
Connects start point and end point as
baseline.

5.3 Analyzing Data

Process

Operation

Manual Peak Integration [Ctrl] + right-click-drag
Delete Identification
Results

Explanation
Connects points with horizontal baseline.

[Shift] + [Ctrl] + right-double-click Voids identification and removes
quantitative calculation results.

When peaks are integrated for quantitation, concentrations calculated from the calibration curve are
displayed.
However, if no concentration is displayed, character strings shown below are displayed according to
the cause.
Displayed Character String

6

Explanation

No peak is detected.

Quantitative peak integration resulted in no peaks detected.

No peak is found in Window/Band
range.

No peaks were detected within the retention time range
specified for identification.

Ratio of reference ion does not match.

Peak is not identified due to the difference between specified
and measured reference ion ratio values exceeding the
allowable range.

Under the minimum similarity index.

Peak is not identified due to the measured similarity being less
than the specified similarity setting, when mass pattern
matching is specified in identification parameters.

No peak is identified.

Automatic identification results were manually deleted.

---

When the calibration curve is quadratic and the area is
larger than the local maximum value (or smaller than the
local minimum value), "---" is displayed since the
concentration cannot be calculated. The target component
may be out of the measurement range. Confirm the peak.

After checking the results, click

(Save) on the toolbar.

The data file is saved.

Displaying Standard Spectra
Data can be analyzed more easily by comparing the displayed spectrum with a standard spectrum.
When scan mode is used for measurements, data can be analyzed more easily by comparing the
displayed spectrum with a standard spectrum.

1

Click [Spectrum View] - [Display Setting] on the [View] menu. If the [Spectrum Graph Display Setting]
window is displayed, select [Display Standard Spectrum].
The standard spectrum is displayed.
The standard spectrum can be hidden by repeating step 1 above.
When the measured spectrum is enlarged by dragging, the standard spectrum is enlarged
correspondingly.

Basic Operation Guide 63

5

5 Quantitative Analysis

Displaying Reference Data
Compounds can be identified from the shape of chromatograms, retention times, and other information
obtained by referencing measurement data of standard samples or spiked samples.

1

Select [Open Reference Data File] on the [File] menu to open the data file being referenced. The
reference data is displayed.

Closing Reference Data

1

Click [Close Reference Data File] on the [File] menu and specify the reference file to close.
The reference data file closes.

Up to three reference data files can be displayed.
Reference data peaks cannot be integrated.
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5.4 Printing Quantitative Analysis Reports

Fixing the Intensity Axis

1

Right-click in [Quantitative View] and select [Fix the Intensity Axis to this Data] on the menu
displayed to fix the intensity axis.

5
5.4 Printing Quantitative Analysis Reports
It is convenient to use a template to create a report of analyzed data.

5.4.1 Creating and Outputting Quantitative Analysis Reports

1

Click the [Report] icon on the [Quantitative] assistant bar.

2

Click [New Format File] on the [File] menu.

The [Data Report] window opens.

The [File New] window opens.
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5 Quantitative Analysis

3

4
5

Select [Use Template] and select the format [Quantitative Analysis Report].

Click [OK].
The [Quantitative Analysis Report] format opens.

Click the [Preview] icon on the [Data Report] assistant bar.
The print preview window opens.
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5.4 Printing Quantitative Analysis Reports

6

After checking the report content, click [Print] to print the report.

5

7

Click

(Save) on the toolbar.

The report is saved as a data file.
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6

6

Shutting Down GCMS

6.1 Vacuum System Shutdown

1

Click the [Vacuum Control] icon on the [Real Time] assistant bar.

2

Click [Auto Shutdown].

3

When [Completed] is displayed, click [Close].

The [Vacuum Control] window opens.

The vacuum system shuts down.
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6.2 Turning OFF the Power

6.2 Turning OFF the Power
Turn OFF the power by performing the procedure for turning ON the power in reverse.
If accessory/peripheral equipment is connected, switch OFF the accessory/peripheral equipment
power last.
^ Reference
See "2.1 Turning ON the Power" P.4 for details on how to turn ON the power.

1
2
3
4

Quit the [GCMS Real Time Analysis] program and all other programs that are running.
Turn OFF the power to the PC, printer, and display.
Turn OFF the power to the MS unit.

6

Turn OFF the power to the GC unit.
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A

File Format

GCMSsolution uses the file formats described below.
File type
Data file

Icon

Extension
.qgd

File contents
In addition to the raw data acquired (e.g., chromatograms and spectra),
the following information is saved.
• Calculation results such as area values and concentrations
• Status information such as the oven temperature and error status at
the time data is acquired
• Contents of method files used in analysis (including configuration
settings used for analysis)
• Contents of report format file (when reports are output)
• Contents of batch files (when batch processing is performed)
• Contents of tuning file used in analysis
Analysis conditions, peak integration parameters, compound tables, etc.
are saved.
Because the configuration settings are saved when the method is edited,
the configuration settings are checked when the method file is loaded to
ensure that they agree with the current settings. Created calibration curves
are also saved in the method file.
The report format information used to output a report, such as layout
information and detailed settings, is saved.
Once a report format file has been created, it can be used repeatedly to
output reports of the same format.
Batch tables used to perform automatic sequential processing are saved.
The same files can be used in both the [GCMS Real Time Analysis]
program and the [GCMS Postrun Analysis] program.

Method file

.qgm

Report format
file

.qgr

Batch file

.qgb

Tuning file

.qgt

The conditions used to perform instrument adjustment (tuning) and the
tuning results are saved.

Library file

.lib

These files are used to register the compound information and spectral
data used to perform similarity searches.
The libraries consist of public libraries (e.g., NIST and Wiley) and private
libraries.
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B

Appendix

B

Viewing Help

If you do not know how to perform a procedure, refer to Help using one of the procedures described below.

B.1 Displaying Help from the Menu Bar

1

B
B

Click [Contents] on the [Help] menu displayed in the menu bar of a window to display
the [GCMS Help window].

B
B
B
B
B

Searching from the [Contents] Tab

1

B

Double-click the applicable topic.

Searching from the [Index] Tab

1
2

B

Type the applicable word.
Select the applicable topic and click [Display].

B

Searching from the [Search] Tab

1
2

Type the applicable word and click [Search].
Select the applicable topic and click [Display].

B

B.2 Displaying Help with the F1 Key

1

B

Press the [F1] key on the keyboard.

B

Help for the open window is displayed.

B
B
Basic Operation Guide 71

C

Appendix

C

Single Analysis
(Manual Injection)

Use the procedure described below when analyzing samples one-by-one using the autosampler or
when performing analysis using manual injection.

1

Start the [GCMS Real Time Analysis] program, then click the [Data Acquisition] icon on

2

Double-click the method file to be used in Data Explorer.

3

Click the [Sample Login] icon on the [Acquisition] assistant bar.

the [Real Time] assistant bar.
The [Acquisition] window opens.
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The [Sample Login] window opens.

1

2

3

1
2
3

Enter [Sample Name] and [Data File].
When using an autosampler, input [Vial #] in which the sample is set and [Injection Volume].
Click [OK].

[Tuning File] is not set usually. If it is left blank, the tuning file saved in the previous tuning will be
used.

4

When using an autosampler, set syringe rinse solvent and samples in the specified

5

Click the [Download] icon on the [Acquisition] assistant bar.

positions.

The method file settings are transferred to the instrument.
When preparation for GC and MS has been completed, the [Start] icon turns green, indicating that it can
be selected.
If using autosampler model AOC-20i, the analysis starts automatically.

• In manual injection mode, inject the sample and then press [START] on the GC unit keyboard.
• If using accessory/peripheral equipment, start such equipment first, then click the

(Start)

icon.
• To abort analysis before completion, click the

(Stop) icon on the [Acquisition] assistant bar.
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D

Batch File

D.1 Generating Filenames Automatically
In the [Settings] window displayed when clicking [Settings] on the [Batch] assistant bar, data
filenames can be generated automatically. The settings are saved in the batch file.

1

Start the [GCMS Real Time Analysis] program. Click the [Settings] icon on the [Batch]

2

Specify the format of the data file names to be automatically created.

assistant bar.

2

1

3

4

1
2
3
4

Click the [Data Filename] tab.
Select the [Create filenames automatically with] checkbox.
Add or delete items in the [Selected Items] box.
Click [OK].
When the settings are complete, the [Data File] column in the batch table is highlighted in yellow.

Example: Automatically generating data filenames by putting [Batch Start Date] and [Sample Name] in the
[Selected Items] box
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D.2 Editing a Batch File

Batch Start Date

20131220

Sample Name

Datafile (.qgd)

Standard 1ppb

20131220_Standard 1ppb_1

Standard 10ppb

20131220_Standard 10ppb_2

Standard 100ppb

20131220_Standard 100ppb_3

Unknown

20131220_Unknown_4

Unknown

20131220_Unknown_5

D

Symbols that cannot be used in a data filename, such as "/" should not be included in the sample
names.

D

D.2 Editing a Batch File

1

D
D

Modify a batch file.

D
1
When analyses are in progress, both the [Batch
Table] window and [Acquisition] window are
displayed. To switch to the [Batch Table] window,

D
D
D

2

D
D
D

1
2

D

Click on the table.
Click the [Pause/Restart] icon on the [Batch] assistant bar.
The [Batch Table] window opens, allowing unexecuted rows to be edited.

D

Analysis of rows currently being analyzed will continue to be executed.

D
D
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D Batch File

2

Edit the batch table.

3

Click

4

Click the [Pause/Restart] icon on the [Batch] assistant bar.

Right-click on the row to be edited, then select [Add Row], [Delete Row], or other action on the menu that
appears.
The vial number, data file name, or other information can be changed as well.

(Save) on the toolbar.

The analysis restarts.

Some accessory/peripheral equipment may prevent using this function.
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D.3 Adding Batch Files (Batch Queue)

D.3 Adding Batch Files (Batch Queue)
D.3.1 Creating Batch Files to Add

1
2

Double-click the

D

(GCMS Analysis Editor) icon.

The [GCMS Analysis Editor] program starts.

Click the [Batch Processing] icon on the [Real Time] assistant bar.
The [Batch Table] window opens.

D
D
D
D

3

D
Create the batch file to be added.

D
D

4

D
Name and save the batch file.

D
D
D
D

• The analysis will not start if the same data file name is used more than once or the specified method file
does not exist.
• The batch queue is not activated until the [GCMS Analysis Editor] program is closed.

5

D
D

Quit the [GCMS Analysis Editor] program.
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D Batch File

D.3.2 Adding Batch Files

1
2

Start the [GCMS Real Time Analysis] program.
Click the [Batch Table] window.
The content of the toolbar, menu bar, and assistant bar changes.

3

Select [Batch Queue] on the [Batch] menu.

4

Click [Add] to open the batch file to be added.

The [Batch Queue] window opens.

If multiple batch files were added, change their order by clicking the desired batch file, then clicking
[Move Up] or [Move Down]. Then analysis starts in that order from the top.

5

When finished editing, click [OK].
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E

Reducing the Carrier Gas
Flow Rate During Standby

Reducing the carrier gas flow rate after analysis is finished is recommended to reduce carrier gas
consumption.

E.1 Ecology Mode

E
E

Using the ecology mode reduces power consumption and carrier gas consumption during standby for
analysis.
To cancel the ecology mode, click [Cancel] in the [Ecology Mode] window.
When the ecology mode is canceled, settings before switching to the ecology mode are restored.

E
E
E
E
E

E.1.1 Setting the Mode Manually

1

E

Click the [Ecology Mode] icon in the instrument monitor.
A message window opens.

E
E
E
E

2

E

Click [Yes].
The [Ecology Mode] window opens and the mode switches to the ecology mode.
After switching to the ecology mode, the column oven temperature and the total carrier gas flow rate
decrease. (For the TQ series model, CID gas supply stops.)

E
E
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E Reducing the Carrier Gas Flow Rate During Standby

The [Ecology Mode] window is displayed when in the ecology mode. Cancel the ecology mode
before using [GCMS Real Time Analysis] to perform operations in other windows.

E.1.2 Setting the Mode Using Batch Processing
This allows switching the instrument to the ecology mode after the entire sequential analysis is
finished.

1

Click the [Batch Processing] icon on the [Real Time] assistant bar.

2

Create and save a batch file.

3

Select [Enters Ecology Mode when ending Realtime Batch] on the [Batch] menu.

The [Batch Table] window opens.
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E.2 Reducing the Carrier Gas Flow Rate During Standby

4

Click the [Start] icon on the [Batch] assistant bar.

E

5

When the ecology mode confirmation message appears, click [Yes].
The mode switches to the ecology mode after the sequential analysis is completely finished, including the
batch queue.

E
E
E
E

The setting can be canceled by repeating step 3, but leave the setting as it is.

E

E.2 Reducing the Carrier Gas Flow Rate During Standby

E

For models QP2010, QP2010 Plus and QP2010S, perform the following operations.

E.2.1 Creating a Method File That Reduces the Carrier Gas Flow Rate
As an example, the following describes how to create a method file that reduces the total flow rate to
20 mL/min.

1

Start the [GCMS Real Time Analysis] program, then in Data Explorer, double-click the
method file to be used for sequential analysis.

E
E
E
E
E
E
E
E
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E Reducing the Carrier Gas Flow Rate During Standby

2

Change [Total Flow] to 20 mL/min, then name and save the method file.

E.2.2 Creating Batch Files

1

Click the [Batch Processing] icon on the [Real Time] assistant bar.
The [Batch Table] window opens.
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E.2 Reducing the Carrier Gas Flow Rate During Standby

2

In Data Explorer, double-click the batch file to be used for sequential analysis.

E

3

Right-click on the batch table and select [Table Style] on the menu that appears.
The [Table Style] window opens.

E
E
E
E
E
E
E

4

Click [Run Mode] in the [Hide Items] list, then click [Add>>] and [OK].

E
E

A [Run Mode] column is added to the end of the batch schedule.

E
E
E
E
E
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E Reducing the Carrier Gas Flow Rate During Standby

5

Edit the batch file.

6

Click the [Run Mode] cell for the row that specifies the method file that reduces the flow

7

Configure [Run Mode] settings as shown below, then click [OK].

8

Name and save the batch file, then click the [Start] icon on the [Batch] assistant bar.

Add a row at the end and select a method file created in "Appendix E.2.1 Creating a Method File That
Reduces the Carrier Gas Flow Rate" P.81.
Vial number, level number, and injection volume settings do not need to be changed from their default
values. Enter a data file name that is not the same as any other row.

rate, then click the arrow button that appears.
The [Run Mode] window opens.

During this process, the method file for reducing the carrier gas flowrate is loaded when the final row is
reached, and continuous data acquisition ends when the flowrate reaches 20 mL/min.
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F

Appendix

F

Peak Integration for Total Ion
Current Chromatogram (TIC)

When qualitatively analyzing multiple components, perform peak integration as described below to
make the analysis operation easier.

1
2

F
F

Double-click the

(GCMS Postrun Analysis) icon.

F

The [GCMS Postrun Analysis] program starts.

Click the [Qualitative] icon on the [Postrun] assistant bar.

F
F
F
F

3

F

Open the data file.

F
F
F
F
F
F
F
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F Peak Integration for Total Ion Current Chromatogram (TIC)

4

Set the peak integration parameters and perform peak integration for the entire TIC.

1

Click the [Peak Integration for All TICs] icon on the [Qualitative] assistant bar.

2

Click the [Peak Integration] tab in the [Quantitative Parameters] window.

2
3
4

5

3
4
5

5

Click [Auto(Area)].
Set a value in [# of Peaks].
Click [OK].

Open the TIC peak table and check the peaks detected.

1

2

1
2

Click the [Qualitative Table] icon on the [Qualitative] assistant bar.
The [Qualitative Table] window opens.
Click the [TIC] tab.
The results for peak integration now can be checked.
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6

Click [Select All] on the [Edit] menu.

F

7

F
Click [Edit] menu again and then click [Register to Spectrum Process Table].

F
F
F

8

F
Perform similarity search for every row.

2

F
F

1

1
2

Click the [Spectrum Process] tab in the [Qualitative Table] window.

F
F

Click [Search All Table] on the [Similarity Search] menu.
[Done] is displayed in the [Search] cell.

F
F
F
F
F
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F Peak Integration for Total Ion Current Chromatogram (TIC)

9

Double-click the first row and check the similarity search results in order.
1 2

3

6

5

4

No.

Explanation

1 Similarity: The closer this value is to 100, the greater the similarity in mass spectra.
2 To enter a compound name in the spectrum table, select the box for the applicable compound.
3 Click to copy the selected compound names to the spectrum table.
4 Use to switch between the mass spectra for the compounds found.
5 Hit numbers for the compounds found.
6 Allows switching between search results for each row in the spectrum process table.
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Modifying the TIC Table
If peaks cannot be detected properly by automatic peak integration, take the following actions.

Phenomena
No peak is detected.

Corrective Action
Click [Manual Peak Integrate] - [TIC] on the [Qualitative]
menu to perform peak integration of the target
compounds.

F
F
F
F

Overlapped multiple peaks are identified as a single Click [Sprit Peak] on the [Qualitative] menu and move
peak.
the mouse pointer to the desired position for peak
splitting.

F
F
F

Peaks are detected and identified, but peak
integration has not been done correctly.

Delete the row(s) from the TIC peak table.

F
F
F
F
F

Copying the Hit #1 Compound Name in the Spectrum Process Table

F
F

If [Copy Compound Name of Hit #1 to Spectrum Process Table] is selected, the name of the compound that
was hit first in the similarity search can be automatically entered. However, it is necessary to confirm that the
first hit compound is actually the target compound because it might not be.

F
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G

Index Searches

It is possible to search for information related to the target compounds (e.g., spectra and information
on the structure) in the library.

1

Click the [Library Editor] icon on the [Postrun] assistant bar.

2

Click [Open Library] on the [File] menu to open the library to be used.

3

Click the cell in the [Index] column to select an item.

4

Enter information for the index item in the [Parameter] column for the row where the

The [Library Editor] window opens.

The library opens.

index item was selected.
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5

Click [Start] on the [Index Search] menu.

6

Confirm the applicable information (e.g., spectrum or structure).

The results are displayed.

G
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H

Displaying Mass
Chromatograms (MC)

Displaying the appropriate mass chromatogram while analyzing data for qualitative analysis makes
analysis easier.

 Confirming the Purity of Peaks
Displaying mass chromatograms can be used to check the presence of two or more overlapping peaks, or
in other words, to check the purity of a peak in the chromatogram.

 Looking for Target Compound Peaks Among Multiple Peaks
In some cases, peaks for target compounds cannot be confirmed in a total ion chromatogram (TIC).
If characteristic mass spectral peaks (i.e., m/z) of the target compounds are known, displaying the mass
chromatograms makes it easier to check the position of the target compound's peaks in the chromatogram.

Perform the operation as described below.

1
2
3
4

Perform "Index Searches" P.90 to check the mass spectra of the target compounds.
Check one to three ions in the high m/z region.
Enter m/z values in the fragment table and display the mass chromatograms.
Perform similarity searches for the mass spectra of the target peaks.
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H.1 Displaying Chromatograms from Mass Spectra

H.1 Displaying Chromatograms from Mass Spectra

1

In the mass spectrum, specify and enlarge the range containing the desired peaks by

2

Move the mouse pointer to the spectral peak to be displayed and double-click.

dragging the mouse.

A mass chromatogram is displayed in the MC window, enlarged by an automatically set enlargement rate.

• To hide the mass chromatogram, deselect the applicable cell in the [Disp.] column in the [MC Fragment
Table] window.
• To undo enlarging, right-click on the mass spectrum and select [Undo Zoom] on the menu that appears.

H
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H Displaying Mass Chromatograms (MC)

H.2 Displaying Chromatograms from Fragment Tables

1

Click the [Fragment Table] icon on the [Qualitative] assistant bar.

2

Enter the applicable values in the [m/z] and [Factor] columns, select the corresponding

The [MC Fragment Table] window opens.

cells in the [Disp.] column, and click [OK].
A mass chromatogram is displayed in the MC window.
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H.2 Displaying Chromatograms from Fragment Tables

The display can be changed as shown below by enabling/disabling [Base Shift] in the table.
• With Base Shift

• Without Base Shift

H
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I

Editing Parameters for
Quantitative Analysis

Change quantitative processing parameters as necessary.

1
2

3

Start the [GCMS Postrun Analysis] Program and open the method file.
Click the [Quantitative Parameters] icon on the [Calibration] assistant bar.
The [Quantitative Parameters] window opens.

Click the [Quantitative] tab.
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4

Change the [Curve Fit Type], [Zero], and [Weighted Regression] settings, as necessary.

1
2
3

No.

5

Item

Explanation

1

Curve Fit Type

Specifies how to plot the calibration curve.
• Linear: Determines the calibration curve as a straight line from the obtained
values.
• Point to point: Points are connected by a broken line. No formula is displayed
for point to point calibration curves.
• Quadratic: Curve is fit to each point using a quadratic equation. This requires
at least three points on the calibration curve. For two points or less, the curve
is calculated as linear.
• Mean RF: First, it determines straight lines passing through the origin and
each point. Then it finds the simple average of the slopes for each line.

2

Zero

Select either [Not Forced] or [Force Through]. Normally, select [Not Forced].

3

Weighted
Regression

A typical least squares method of plotting calibration curves could result in a
quantitation error that is larger the lower the concentration at the calibration point. In
general, when the calibration curve has a large dynamic range (maximum
concentration is at least 50 times higher than the minimum quantitation limit),
formulas are weighted to reduce the weight of higher concentration points of the
calibration curve. Typically, formulas are optimized by checking the correlation
coefficient and contribution ratio.
• [1/C2]: Formulas are weighted by the inverse of the concentration value
squared.
• [1/C]: Formulas are weighted by the inverse of the concentration value.
• [1/A2]: Formulas are weighted by the inverse of the area value squared (or
height value when a height is specified for the data used).
• [1/A]: Formulas are weighted by the inverse of the area

After finishing making changes, click [OK].
Calibration curves are corrected according to the changed parameters.

I
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J

Printing Reports

Reports can be output from GCMSsolution using the two methods described below.
• Image printing : The image in the displayed window is automatically converted to a report.
• Report creation : A report format is set and output manually.

J.1 Printing Images (Printing Spectra and

Chromatograms Displayed in Windows)

1

Call up the applicable data in the [Data Analysis] window in the qualitative or

2

Display the chromatogram and mass spectrum in the window in the way desired for the

quantitative processing modes of the [GCMS Postrun Analysis] program.

report.
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J.1 Printing Images (Printing Spectra and Chromatograms Displayed in Windows)

3

Point to [Print Image] on the [File] menu and select [Edit Format].
The [Report] window opens.

J
J
J
J

4

J

Adjust the size as necessary.

J
J
J
J
J

5

J
After editing, click the [Print] icon on the [Report] assistant bar.

J

The report is output.

J
J

6

J

After outputting the report, close the [Report] window.
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J Printing Reports

J.2 Creating Reports
With report creation, reports are output after setting report formats or using previously created
templates.
Process and save the results to be output (such as spectral information) in advance.

1

Open the applicable data in the [GCMS Postrun Analysis] - [Data Analysis] window.

2

Click the

The same report is output for both the qualitative and quantitative windows.

(Report) icon on the [Qualitative] or [Quantitative] assistant bar.

The [Data Report] window opens.

J.2.1 Using Templates

1

Select [New Format File] on the [File] menu.

2

Select [Use Template], select the applicable template, and click [OK].

If this selection window is not displayed, select [Option] on the [Tool] menu to display the [Setting
Options] window and, on the [File New] tab, select [Prompt on File New] for the report format file.
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J.2 Creating Reports

J.2.2 Using Previously Created Report Files

1

In Data Explorer, double-click the report file to be used.

J
J
J
J

J.2.3 Manually Setting Report Content

1

Click the buttons on the toolbar for the information to be printed or select the desired
items on the [Item] menu.
Icon

J
J

Name
Sample information

Explanation
Select to print sample information.

Method

Select to print methods.

Peak table

Select to print the peak tables in qualitative tables.

Chromatogram

Select to print the chromatograms (TIC, MIC, and MC).

J

Spectrum graph

Select to print the mass spectra registered in spectrum processing tables.

J

Mass table

Select to print the mass tables for the spectra registered in spectrum
processing tables.

J

Quantitative graph

Select to print the chromatograms and quantitative values obtained in
quantitative results.

J

Quantitative table

Select to print the tables obtained in quantitative results.

J

Calibration curve

Select to print calibration curves.

Tuning

Select to print the tuning results obtained when data acquisition is
executed.
Select [GC/MS Tuning] or [GC/MS/MS Tuning] icon.

Library search

Select to print the library search results obtained for the mass spectra
registered in spectrum tables.
• Searches must be performed in the spectrum tables.

J
J
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J
J

J Printing Reports

2

Drag the mouse in the layout view to specify the print range.
The properties window for the item being laid out opens.

Drag mouse diagonally

3

Set [Properties] and click [OK].

^ Reference
Refer to Help for details on property settings.

To display a properties window again, double-click on the corresponding item.
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J.2 Creating Reports

4

Click the [Preview] icon on the [Data Report] assistant bar and check the contents of the
report being output.

J
J

5

After the checking the report content, click [Print] to output the report.

J
J
J
J
J
J
J
J
J

6

Select [Save Format File As] on the [File] menu to name and save the report file.

J

This allows loading the report format in the future to create reports easily.

J
J
J
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K

Appendix

K

Maintenance

K.1 Maintenance
Replace or clean the consumable items and maintenance parts as necessary, referring to the [MS
Navigator] window using the procedure described below.

1
2

3

Double-click the

(GCMS Real Time Analysis) icon.

The [GCMS Real Time Analysis] program starts.

Select [Maintenance] on the [Help] menu.
The [MS Navigator] window opens.

Click on the instrument for which maintenance will be performed.
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K.1 Maintenance

4

Read the precautionary information carefully and then click the applicable item under

5

Perform maintenance by following the instructions displayed on the screen.

the maintenance menu.

Click an image to enlarge it. Click [Back] in the enlarged window to return to the original window.

To perform another maintenance item, click [Back] and repeat the procedure from step 3.
After completing maintenance, close the [MS Navigator] window.
After performing maintenance, reset the usage frequencies and usage times using the procedure
described in "Appendix K.3 Changing Replacement Guidelines for septa and Glass Inserts" P.108.
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K

K Maintenance

K.2 Easy sTop
Using Easy sTop allows replacing septa and glass inserts without stopping the vacuum system.
Therefore, it significantly reduces the time required for stabilizing the system after replacement and
eliminates the need for autotuning.
To protect columns, Easy sTop keeps the temperature of the sample injection unit, column oven, and
interface at 70 °C or below. Consequently, it can take about 30 minutes depending on the settings
until glass inserts and septa can be displayed.

1

Double-click one of the icons for consumables in the instrument monitor.

2

Click [Easy sTop].

The [Consumable] tab page opens in the [Monitor Settings] window.

The [Easy sTop] window opens and the injection unit, column oven, and interface temperatures decrease.
When each temperature reaches 70 °C or lower, the "Push the replace button" status is displayed in the
[Easy sTop] window.
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K.2 Easy sTop

3

Click [Replace], then replace septa or glass inserts in the sample injection unit.
For replacement procedures, refer to the septum replacement procedure or insert replacement procedure
in the [MS Navigator] window.

Clicking [Replace] stops the supply of carrier gas.
If left in that state for extended periods, it could reduce column performance. Therefore, replace
septa and inserts as quickly as possible.

4

After replacement, click [Complete] in the [Easy sTop] window.

5

Reset the usage counter for the septum and glass insert.

If there is no air leaking in, the sample injection unit, column oven, and interface temperatures return to
their previous temperatures before Easy sTop started.

For instructions on how to reset usage counters, see the procedure on page 108, starting with step 3.

K
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K Maintenance

K.3 Changing Replacement Guidelines for septa and
Glass Inserts

For septa, replacement frequency varies depending on the syringe needle diameter. The septum can
be used about 100 times with the recommended syringe, and about 30 times with a gastight syringe
before replacement.
Glass insert replacement frequency varies depending on the sample. Set replacement guidelines
based on the sample.

1

Click the [System Configuration] icon on the [Real Time] assistant bar.

2

Double-click [SPL1] under [Modules Used for Analysis].

The [System Configuration] window opens.

The [Modules of Analytical Line #1] window opens.
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K.3 Changing Replacement Guidelines for septa and Glass Inserts

3

Click [Injection Port Maintenance].

4

Input [Septum Used Counts] and [Insert Used Counts] settings.

5
6
7

The [Injection Port Maintenance (SPL1)] window opens.

To restore default settings, click [Default].

Click [OK].
The [Modules of Analytical Line #1] window returns.

Click [OK].
The [System Configuration] window returns.

Click [Set].

The replacement guidelines for septa and glass inserts are changed.

K
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L

Appendix

L

Quantitative Browser

L.1 Data Analysis using Quantitative Browser
Using this browser allows multiple samples to be quantitatively processed at one time.
5

1

2

4

No.
1

Item
[Quantitative
Result View]

3

Explanation
Use to check the quantitative calculation results (area, concentrations, etc.) of
multiple data files. Click

to switch between compounds to display.

2

[Compound Table Click the [Results] tab to check the quantitative values of each compound in the
View]
data file selected in [Quantitative Result View].

3

[Calibration Curve Displays a calibration curve of the ID selected in [Compound Table View].
View]

4

[Chromatogram
View]

Displays chromatograms of the compounds that are in the data files selected in
[Quantitative Result View] and also selected in [Compound Table View].

5

Sample Type
Toolbar

Data files for the specified sample type can be displayed in [Quantitative Result
View].
All: All sample types, Std: Standard samples, Unk: Unknown samples
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L.1 Data Analysis using Quantitative Browser

L.1.1 Loading Data Using Quantitative Browser

1
2

Double-click the

(GCMS Browser) icon on the desktop.

Click the [Quant Browser] icon on the [Browser] assistant bar.

3

Click the [Batch] tab in Data Explorer.

4

Drag and drop the batch file used for analysis into [Quantitative Result View].

Individual data files can be dragged and dropped to open. In addition, right-click a desired row and
then click [Delete] to delete a data file.

L
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L Quantitative Browser

L.1.2 Checking and Correcting Calibration Curves

1

Click the [Modify Calibration Curve] icon on the [Quant Browser] assistant bar.

2

Check the calibration curve and make necessary corrections.
^ Reference
Refer to "5.3.1 Checking and Correcting Calibration Curves" P.54 for the operation procedure.

3

Click the

(Top) icon on the [Calibration] assistant bar.

When the [Quant Browser] window appears, quantitative recalculation is done based on the corrected
calibration curve.

L.1.3 Checking and Correcting Quantitative Results of Unknown
Samples

^ Reference
If necessary, perform identification or peak integration with reference to "Manual Identification and
Manual Peak Integration" P.57.
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L.2 Saving Data Files

The same process can be accomplished more easily by performing the following operations on the
chromatogram.
Process
Manual Identification

Operation
[Shift] + [Ctrl] + right-click

Explanation
Identifies integrated peaks.

Manual Peak Integration [Shift] + right-click-drag

Connects start point and end point as
baseline.

Manual Peak Integration [Ctrl] + right-click-drag

Connects points with horizontal baseline.

Delete Identification
Results

[Shift] + [Ctrl] + right-double-click Voids identification and removes
quantitative calculation results.

The intensity axis in [Chromatogram View] can be fixed by moving the mouse pointer to the desired
data file in [Quantitative Result View], right-clicking it, and then clicking [Fix the Intensity Axis to this
Data].

L.2 Saving Data Files

1
2

Click

(Save) on the toolbar.

The data file is saved.

Click [Save Browsing File As] on the [Layout] menu.
Enter a name and save the file. The browsing file (that stores information on the loaded data files) is
saved.

L
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L Quantitative Browser
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